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Abstrak 

 

Analitika data keuangan negara merupakan sekumpulan kerangka konsepsual yang digunakan untuk mengidentifikasi, 

mengekstraksi, dan mendapatkan pola atau anomali tertentu dari berbagai data keuangan negara untuk selanjutnya dapat 

disajikan dalam bentuk wawasan (insights), visualisasi ataupun model yang diharapkan dapat membantu pengambilan keputusan 

yang berkaitan dengan berbagai fungsi dan bidang pengelolaan keuangan negara. Penelitian ini dengan menggunakan rancangan 

penelitian deskriptif kualitatif menjelaskan bagaimana analitika data keuangan negara dapat dilaksanakan dengan menggunakan 

use case data dasar Dana Alokasi Umum (DAU) yang telah tersedia dan dapat diakses secara bebas oleh publik melalui situs 

web Kementerian Keuangan. Kajian ini menggunakan kombinasi beberapa paket perangkat lunak dan teknik analisis data untuk 

menyajikan berbagai insights yang dapat disajikan dari data yang telah tersedia tersebut. Penelitian ini dengan use case yang ada 

menemukan bahwa data keuangan negara telah disajikan dengan struktur data standar relatif memudahkan para pihak yang ingin 

menggunakan data tersebut untuk berbagai kepentingan. Rekomendasi kebijakan yang diajukan berdasarkan hasil kajian ini 

adalah: (1) data yang disediakan dapat mencakup seluruh data yang berkaitan dengan pengelolaan keuangan negara; (2) data 

disediakan dalam struktur standar sehingga memudahkan pengguna yang membutuhkan data tersebut. Untuk cakupan organisasi 

pemerintahan dalam skala yang lebih besar, penelitian ini merekomendasikan agar setiap instansi pemerintah dapat menyediakan 

data operasionalnya dengan struktur data yang mudah untuk diolah kembali sehingga memungkinkan data tersebut digunakan 

untuk kepentingan publik yang lebih luas. 

 

Kata Kunci: Analisis, Data, Keuangan, Negara. 

 

Data Analytics in State Finance Management: Use Case of General 

Allocation Fund 
 

Abstract 
 

Government financial data analytics is a bunch of concepts that are used to identify, extract, and obtain certain patterns or 

anomalies from various government financial data which then could provide some insights in the form of visualizations or 

models. This research uses descriptive qualitative research that explains the analytics of state financial data can be done using 

basic case data of the “Dana Alokasi Umum (DAU)”, i.e. general allocation fund transferred from central to subnational 

government, which has been available and can be accessed by the public through the Indonesian Ministry of Finance's website. 

This study uses a combination of several software packages and data analysis techniques to present various insights that can be 

presented from the data that is already available. This study uses a case that finds state financial data provided with a standard 

data structure that makes it easy for those who want to use the data for various purposes. The policy recommendations proposed 

based on the results of this study are: (1) the data provided can complement all data relating to the management of the financial 

state; (2) data provided in a standard structure so as to enable users who need the data. To support government organizations 

on a larger scale, this study asks that each government be able to provide operational data with data structures that are easy to 

reprocess to facilitate data used for the wider community. 

 

Keywords: Anaysis, Data, Finances, State. 
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I. PENDAHULUAN 

Undang-Undang Nomor 15 Tahun 2004 tentang 

Keuangan Negara (UU KN) mendefinisikan pengelolaan 

keuangan negara sebagai keseluruhan kegiatan pejabat 

pengelola keuangan negara sesuai dengan kedudukan dan 

kewenangannya, yang meliputi berbagai fungsi dan bidang. 

Dari sisi fungsi meliputi: perencanaan, pelaksanaan, 

pengawasan, dan pertanggungjawaban. Sementara itu dari sisi 

bidang mencakup perpajakan, anggaran, perbendaharaan, 

dana transfer ke pemerintah daerah, aset, hingga pembiayaan 

negara. Cakupan pekerjaan pengelolaan keuangan negara 

yang sangat luas dan cenderung kompleks tersebut tentunya 

memerlukan dukungan manajemen data dan teknologi 

informasi dan komunikasi yang komprehensif [1]–[6]. Salah 

satu dukungan dari sisi ini adalah kemampuan analisis data 

yang terkait dengan data tersebut juga sangat luas 

cakupannya, dari yang bersifat makro untuk perencanaan 

APBN sampai dengan data mikro yang terkait dengan 

kepatuhan pajak ataupun pencairan belanja untuk pelaksanaan 

APBN. Situasi yang terkini dari implementasi teknologi 

informasi di lingkungan pengelolaan keuangan negara 

mengarah pada analitika data sebagai upaya dari berbagai 

otoritas pengelolaan keuangan negara untuk mendapatkan 

insights dari data yang berada dalam cakupan kewenangannya 

untuk digunakan sebagai pendukung pengambilan keputusan 

atau kebijakan keuangan negara [7], [8]. 

Perkembangan analitika data pada pemerintahan telah 

menunjukkan perkembangan yang pesat. Archeena dan Anita 

[9] menekankan bahwa tantangan analitika data publik di 

pemerintahan bukan karena kurangnya data, namun 

kurangnya informasi yang mendukung pengambilan 

keputusan, perencanaan dan strategi. Limpahan data (data 

deluge) umumnya diolah untuk kepentingan dukungan kota 

pintar (smart cities) sebagaimana ditekankan Watson [10]. 

Analitika data publik untuk pemerintahan terus 

dikembangkan manfaatnya dengan bentuk data terhubung 

(linked data) dan inisiatif Open Government Data (OGD) 

[11], [12]. 

Analitika data pada dasarnya dapat digunakan untuk 

mendukung semua fungsi keuangan negara [5], [6], [13], [14]. 

Namun karena data yang berhubungan dengan pengelolaan 

keuangan negara sangatlah beragam, kajian ini memilih untuk 

menggunakan data dasar Dana Alokasi Umum (DAU) yang 

telah disediakan secara terbuka (open data) sebagai use case 

(lihat misalnya [15], [16]) dalam kajian ini. Data dasar DAU 

tersebut dapat diakses melalui tautan dalam situs web 

Direktorat Jenderal Perimbangan Keuangan (DJPK) sebagai 

bagian dari Kementerian Keuangan sebagai pengelola 

keuangan negara yang bertugas untuk mengelola dana transfer 

dari pemerintah pusat ke pemerintah daerah. Penggunaan data 

yang telah tersedia untuk publik ini pada gilirannya 

diharapkan dapat mendorong para pemangku kepentingan 

pengelolaan keuangan negara untuk menggunakan 

pengetahuan yang didapatkan dari hasil kajian sebagai salah 

satu referensi dalam melakukan pengolahan dan analisis data 

keuangan negara dengan area implementasi yang lebih luas. 

Penelitian ini dengan menggunakan metode observational 

case studies [17] sebagai salah satu metode dalam lingkup 

design science methodology [18]–[22] bertujuan untuk 

menghasilkan suatu artefak teknologi informasi berupa 

prosedur penggunaan perangkat lunak yang dengan 

menerapkan kerangka pengetahuan analitika data (data 

analytics as body of knowledge) untuk kepentingan 

pengelolaan keuangan negara [23] dengan menggunakan use 

case data dasar DAU. Manfaat yang diharapkan dapat 

diperoleh dari hasil penelitian ini adalah adanya tambahan 

rujukan yang dapat digunakan oleh para pemangku 

kepentingan keuangan negara dalam menjalankan masing-

masing perannya. 

Direktorat Jenderal Anggaran [24] merumuskan keuangan 

negara dengan menggunakan beberapa sudut pandang yaitu: 

subjek, dan objek, proses dan tujuan. Dari sudut pandang 

subjeknya, keuangan negara meliputi keseluruhan pelaku 

yang terkait dengan pengelolaan objek berupa semua hak dan 

kewajiban negara yang dapat dinilai dengan uang, termasuk 

kebijakan dan kegiatan dalam bidang fiskal, moneter dan 

pengelolaan kekayaan negara yang dipisahkan, serta segala 

sesuatu baik berupa uang, maupun berupa barang yang dapat 

dijadikan milik negara berhubung dengan pelaksanaan hak 

dan kewajiban tersebut. Sementara dari sudut pandang proses, 

keuangan negara adalah seluruh rangkaian kegiatan yang 

berkaitan dengan pengelolaan objek sebagaimana tersebut 

dari perumusan kebijakan, pengambilan keputusan hingga 

pertanggunggjawaban. Sedangkan dari sisi tujuan, merupakan 

seluruh kebijakan, kegiatan dan hubungan hukum yang 

berkaitan dengan pemilikan dan/atau penguasaan objek dalam 

rangka penyelenggaraan pemerintahan negara. Pelaksanaan 

pengelolaan keuangan negara dari semua sudut pandang di 

atas memerlukan data sebagai proses pendukung pengambilan 

keputusan: 

“… dalam pembahasan dan analisis program-program 

pembangunan nasional dan anggaran, data mengenai 

perkembangan alokasi dan realisasi anggaran dalam APBN 

terkait dengan kegiatan pada bidang-bidang tertentu, juga 

dibutuhkan dalam pengambilan keputusan. Anggaran bidang 

tertentu (tematik) tersebut perlu disiapkan sebagai upaya 

untuk mendukung penerapan performance-based budgeting, 

dalam arti penganggaran yang telah dan akan dilakukan 

disertai dengan capaian dan target yang akan dihasilkan di 

bidang-bidang tertentu. … ” [24]. 

Kajian [5] menunjukkan perlunya pengembangan 

analitika data sebagian dari keseluruhan sistem informasi 

manajemen keuangan negara di Indonesia. Terkait dengan 

implementasi analitika data sebagai dengan sistem informasi 

manajemen keuangan ini diuraikan bahwa: 

“ … Melanjutkan pengembangan DW dan data analytics 

serta penyatuan berbagai monitoring system dalam satu 

aplikasi terintegrasi (OLAP). … Data analytics, termasuk 

penggunaan BI dapat dilakukan sebagai basis untuk simulasi 

kebijakan, sistem monitoring terintegrasi untuk semua K/L 

dan satker, pertukaran data dengan stakeholders terkait, 

pengembangan berbagai mobile applications untuk 

menyampaikan hasil-hasil pembangunan ataupun 
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pengikutsertaan masyarakat dalam monitoring 

pembangunan.” 

Demikian pula kajian [13] yang menyatakan perlunya 

setiap bidang pengelolaan keuangan negara agar menjadikan 

analitika data sebagai bagian dari inisiatif strategis bidang 

tersebut terutama yang terkait dengan implementasi sistem 

informasi dan manajemen data.  

Penelti [25] mendefinisikan analitika data dengan proses 

dan metode dalam analisis data sehingga akhirnya dari data 

tersebut didapatkan wawasan yang mendalam (meaningful 

insight) tentang suatu tema. Sementara itu [26] menyatakan 

bahwa analitika adalah penggunaan data, analisis kuantiatif, 

model eksplanatori dan prediktif, serta manajemen berbasis-

fakta secara ekstentif untuk mempercepat keputusan dan 

tindakan. Analitika bukanlah suatu hal yang sama sekali baru. 

Istilah ini sebenarnya merupakan perkembangan dari berbagai 

istilah yang ada sebelumnya. Pada tahun 1970an, istilah yang 

banyak digunakan adalah Decision Support Systems (DSS). 

Kemudian pada era 1980an nama yang digunakan untuk hal 

ini adalah Online Analytical Processing (OLAP) dan 

Executive Information Systems (EIS). Setelah itu, tahun 

1990an muncul istilah baru yang populer yaitu Business 

Intelligence (BI). Pada tahap berikutnya, istilah analytics dan 

juga data science mulai digunakan secara luas.  

Berdasarkan uraian di atas dapat disimpulkan bahwa 

analitika data adalah sebuah kerangka pengetahuan sebagai 

panduan untuk mengolah berbagai jenis/format data dengan 

bermacam-macam teknik pengolahan dan analisis data 

sehingga memungkinkan penyajian informasi yang dapat 

digunakan untuk mendukung pengambilan keputusan. Dalam 

hal ini, terdapat perbedaan antara analitika (analytics) dengan 

analisis (analysis). Analisis adalah tindakannya, sementara 

analitika adalah kerangka pengetahuan (body of knowledge) 

yang digunakan untuk melakukan analisis [25], [27]. 

Berbagai kerangka konseptual analitika data membedakan 

hal ini berdasarkan kompleksitas proses pengolahan 

informasinya. Merujuk [28] menyatakan bahwa data 

analytics berdasarkan kompleksitas prosesnya dapat dibagi 

menjadi empat, yaitu: (1) descriptive: summarizes activity or 

masters data based on certain attributes; (2) diagnostic: 

detects correlations and patterns of interest; (3) predictive: 

identifies common attributes or patterns that may be used to 

identify similar activity; dan (4) prescriptive: recommends 

action based on previously observed actions. Sementara itu 

[25] dan juga [26] membedakan menjadi tiga saja yaitu: 

deskriptif, prediktif dan preskriptif.  Penjelasan ketiga hal 

tersebut sebagaimana terlihat dalam Gambar 1. 

Dalam kaitannya dengan implementasi analitika data 

untuk pengelolaan keuangan negara, penulis mengadaptasi 

penjelasan [25] dan menggunakannya untuk menjelaskan 

analitika data sebagaimana terpampang dalam Tabel 1. 

Tulisan ini, dengan merujuk kajian Febrian dan Darono 

(2019), mengajukan definisi operasional analitika data 

keuangan negara sebagai sekumpulan kerangka konseptual 

yang digunakan untuk mengidentifikasi, mengekstraksi, dan 

mendapatkan pola atau anomali tertentu dari berbagai data 

keuangan negara untuk selanjutnya dapat disajikan dalam 

bentuk wawasan (insights), visualisasi ataupun model yang 

diharapkan dapat membantu pengambilan keputusan yang 

berkaitan dengan pengelolaan keuangan negara secara 

keseluruhan. 

 

 

Gambar 1. Tiga Tingkatan Dalam Analitika Data Davenport 

(2013) 

 

Tabel 1. Perbandingan Hal Yang Dilakukan Dalam 

Tingkatan Analitika Data 

Jenis 

Analitika 

Hal Yang 

Dilakukan 
Contoh 

Deskriptif 

Apa yang 

sedang atau 

telah terjadi 

Berapa besarnya 

perbandingan antara 

penerimaan Pajak 

Penghasilan (PPh) dengan 

Pajak Pertambahan Nilai 

(PPN) dalam sepuluh tahun 

terakhir? 

Prediktif 

Apa yang 

mungkin 

terjadi 

Berapa kira-kira besarnya 

antara perbandingan PPh 

dengan PPN untuk jangka 

waktu tiga tahun yang akan 

datang? 

Preskriptif 

Apa yang 

yang 

seharusnya 

kita lakukan 

Seharusnya penerimaan PPh 

lebih besar dari penerimaan 

PPN, bagaimana agar 

keadaan itu bisa terwujud? 

Sumber: hasil analisis penulis, diadaptasi dari Lee (2017) 

 

Definisi operasional tersebut kemudian digunakan untuk 

mengembangkan artefak teknologi informasi berupa prosedur 

penggunaan perangkat lunak untuk mengolah dan 

menganalisis data, dengan use case data dasar DAU. Use case 

adalah deskripsi operasional naratif yang bisa juga disertai 

dengan diagram tentang bagaimana suatu sistem digunakan. 

Diagram ini menggambarkan batasan dari sebuah sistem 

(aplikasi), aktor yang terlibat, aktivitas untuk menyelesaikan 

tugas tertentu dan hubungan antar aktor dengan aktivitasnya 

[29], [30]. Merujuk berbagai uraian di atas, use case untuk 

analisis data dasar DAU yang digunakan penelitian ini 

dipaparkan dalam Gambar 2. 
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Gambar 2. Use Case Untuk Analisis Data Dasar DAU 

 

Secara umum sistem yang akan dibuat dapat digambarkan 

dengan Diagram Blok pada Gambar 3. Alur kerja yang 

digambarkan dalam Blok Diagram Sistem adalah user 

melakukan komunikasi dengan sistem website DJPK dengan 

menggunakan aplikasi Power BI Desktop di komputer. Power 

BI Desktop memberikan input untuk mengatur regional 

setting sesuai dengan pembacaan data angka dan tanggal di 

website. Setelah itu, Power BI Desktop mengektraksi data 

website menggunakan python script agar didapatkan tabel 

data secara berulang yang kemudian ditransformasi sesuai 

dengan kebutuhan dan di-load untuk disimpan di 

penyimpanan lokal. Setelah itu dilakukan output data berupa 

visualisasi analisis 10 besar DAU/luas wilayah, analisis 

penduduk/luas wilayah, analisis IKK per provinsi dan analisis 

DAU/luas wilayah dengan peta. 

 

 
Gambar 3. Diagram Blok Analisis 

Selanjutnya, bagian kedua akan menyajikan rancangan 

penelitian yang menjelaskan bagaimana design science 

methodology dapat diterapkan untuk penelitian ini. 

Berikutnya, bagian ketiga akan berisi tentang diskusi 

penelitian untuk menjawab pertanyaan penelitian. Terakhir, 

bagian keempat menyajikan kesimpulan dan rekomendasi 

penelitian. 

 

 

II. METODE PENELITIAN 

Peneliti [20] menyatakan bahwa penelitian yang berkaitan 

dengan pengelolaan keuangan dapat menggunakan 

memanfaatkan kerangka kerja ditetapkan dalam design 

science methodology. Selanjutnya [19] mendefinisikan sains 

desain (design science) sebagai kajian ilmiah dan kreasi atas 

berbagai artefak untuk dapat digunakan oleh manusia sebagai 

sarana dalam menyelesaikan masalah praktis tertentu yang 

menjadi bagian dari keseluruhan masalah yang ingin 

diselesaikan. 

Berikut ini adalah penjelasan ringkas tentang design 

science methodology dengan merujuk gagasan dan kajian 

yang dilakukan oleh [17] dan juga [19]. Metodologi ini 

merupakan penelitian untuk merancang atau menelaah artefak 

sesuai dengan konteksnya. Artefak dalam hal ini adalah 

metode, teknik, notasi, dan algoritma yang digunakan dalam 

sebuah sistem informasi. Sementara itu konteks adalah 

bagaimana artefak tersebut dirancang, digunakan, dievaluasi, 

diperbaiki, atau dihapus dari suatu sistem informasi.  Artefak 

sesuai dengan konteksnya ditujukan untuk memecahkan 

masalah dalam suatu bidang/praktik tertentu. 

Design research dipilih sebagai rancangan penelitian ini 

dengan strategi penelitian pengembangan model dan 

instantiasi berupa artefak yang berkaitan dengan analitika data 

dasar dana alokasi umum (lihat misalnya: [31], [32]). 

Pengumpulan dan analisis data menggunakan studi 

dokumentasi dengan analisis data kualitatif berupa kesesuaian 

antara teknologi yang tersedia dengan permasalahan yang 

akan diselesaikan. Berdasarkan [33], [34] diartikan sebagai: 

(1) konstruksi (constructs): vocabulary and symbols, bahasa 

atau ungkapan untuk memformulasikan fenomena; (2) model 

(abstractions and representations, abstraksi atau 

penyederhanaan dari entitas di dunia nyata untuk mengurangi 

kompleksitas; (3) metode (methods): algorithms and 

practices, panduan untuk penentuan solusi atas suatu masalah, 

langkah demi langkah yang merujuk kepada model yang telah 

dibuat; (4) instantiasi (instantiations): implemented and 

prototype systems, implementasi dari konstruksi, model atau 

metode untuk penyelesaian masalah nyata yang sedang 

dihadapi. 

Berdasarkan uraian di atas maka penelitian ini 

menggunakan design science methodology karena sesuai 

tujuannya untuk mengembangkan sebuah artefak berupa 

prosedur penggunaan berbagai perangkat lunak yang dapat 

mendukung implementasi analitika data keuangan negara 

dengan use case data dasar DAU. Langkah penelitian yang 

yang dilakukan dalam penelitian ini untuk melaksanakan 

metode observational case studies [17] adalah: 

(1) Menetapkan perangkat yang digunakan, dalam hal ini 

adalah Python untuk ekstraksi dan Power BI Desktop 

untuk transformasi data, analisis dan visualisasi data; 

(2) Mengevaluasi kode dalam bahasa Python yang 

dikembangkan oleh [35] yang agar bisa digunakan 

(deployed) untuk kepentingan artefak berupa pembuatan 

template file dalam format PBIX yang dapat digunakan 

untuk mengolah data dasar DAU; 

(3) Memasukkan kode bahasa Python menjadi objek dalam 

Power BI Desktop; 

(4) Melakukan urutan perintah pengolahan data dalam Power 

BI Desktop sehingga data dasar DAU dapat diolah, 

dianalisis dan divisualisasikan. 
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Analitika data yang digunakan dalam kajian ini adalah 

analisis deskriptif dengan didukung oleh beberapa teknik 

visualisasi data. 

 

 

III. HASIL DAN PEMBAHASAN 

Bagian pembahasan ini akan terdiri dari empat subbagian. 

Keempat bagian ini disajikan sebagai pembahasan yang 

berurutan.  Pada bagian ini akan menjelaskan langkah-

langkah yang dilakukan untuk melakukan analitika data DAU 

menggunakan Power BI Desktop. Prosedur yang 

dilaksanakan sesuai dengan use case yang sudah 

dikembangkan adalah sebagai berikut: 

(1) Mengidentifikasi struktur data website yang menjadi 

sumber data dasar DAU; 

(2) Mempersiapkan data peta yang tersedia di internet yang 

sesuai dengan kebutuhan analisis data dasar DAU; 

(3) Mempersiapkan script Python dan Power BI Desktop; 

(4) Extract, transform dan load menggunakan Power BI 

Desktop; 

(5) Analitika data DAU menggunakan visualisasi pada Power 

BI Desktop. 

 

a. Mengidentifikasi Struktur Website Yang 

Menyediakan Data Sumber 

Berikut adalah tampilan struktur website data sumber yang 

dapat dilihat pada Gambar 4.  

 

 
Gambar 4. Website www.djpk.kemenkeu.go.id/datadasar 

 

Selanjutnya, jumlah data yang akan diekstraksi dengan 

filter data jenis dana DAU, subjenis DAU Formula dan Tahun 

2018 untuk seluruh provinsi, kota dan/atau kabupaten yang 

ada di Indonesia adalah sebanyak 542. Berikut adalah 

skenario langkah yang digunakan untuk mengekstraksi 542 

data yang dapat dilihat pada Gambar 5. 

 

 
Gambar 5. Skenario web scrape Data Dasar DAU 

b. Mempersiapkan Data Peta 

Untuk kepentingan visualisasi sebagai bagian dari 

analitika data, salah satu data yang perlu dipersiapkan pertama 

kali adalah data peta. Visualisasi yang akan disajikan dalam 

tulisan ini adalah data DAU per provinsi/kabupaten/kota 

dengan menggunakan tampilan grafis berupa peta Indonesia.  

Salah satu visualisasi yang tersedia di Power BI Desktop 

adalah ArcGIS Maps. ArcGIS Maps adalah sebuah mapping 

platform/sistem pemetaan online yang dibuat oleh perusahaan 

ESRI. Peta ini dipilih karena memiliki kemampuan untuk 

untuk pengumpulan, penyimpanan, pengambilan, analisis dan 

penyajian data spasial jenis apa pun [36], [37].  Data spasial 

yang digunakan adalah data lokasi dari Kota atau Kabupaten 

yang ditambahkan kata “Indonesia” pada bagian akhir. Dari 

data lokasi yang telah dibuat maka dapat ditampilkan oleh 

ArcGis Maps, Peta lokasi Indonesia yang dapat dilihat secara 

lebih rinci pada bagian berikutnya. 

 

c. Mempersiapkan Script Python Dan Power BI Desktop 

Untuk membantu mengekstrak data DAU Formula tahun 

2018 sebanyak 542 kali, maka penulis menggunakan kode 

Python yang tersedia pada link website 

http://bit.ly/BetaAutomasiDataDasarDAU [35]. Sesuai syarat 

dan ketentuan dalam tautan tersebut, kode ini dapat diubah 

dan digunakan kembali secara bebas. Untuk itu, kode terlebih 

dulu diedit agar data keluarannya sesuai dengan yang 

dibutuhkan dan dalam format yang dikenali oleh perangkat 

Power BI Desktop.  

Sebelum mengekstraksi website menggunakan kode 

Python tersebut, pada Power BI Desktop dilakukan 

pengaturan awal terkait dengan Regional Setting dari website 

data dasar DAU yaitu Indonesia. Langkahnya adalah sebagai 

berikut: 

a. Buka Power BI Desktop → File → Options and settings 

→ Options, 

b. Regional Settings → select Indonesia. 

Tujuan dari pengaturan Regional Setting adalah 

menghasilkan pembacaan data yang benar oleh Power BI 

Dekstop untuk jenis data berupa angka dari website yang akan 

diekstraksi. 

 

d. Extract, Transform, dan Load Menggunakan Power BI 

Desktop 

Langkah berikutnya adalah melakukan Extract, 

Transform dan Load (ETL) data DAU Formula tahun 2018. 

Langkah yang dilakukan adalah sebagai berikut: 

1) Buka menu Power BI Desktop → Get Data → More → 

Other → Python script → Connect (lihat Gambar 6). 

 

Gambar 6. Get Data dari Power BI dengan Python Script 

2) Pada kolom Python script, pindahkan kode yang telah 

dipersiapkan (lihat Gambar 7). 
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Gambar 7. Insert Python Script ke Power BI 

 

3) Pada jendela Power BI, pilih menu Navigator → 

Transform. 

4) Selanjutnya baris pertama yang telah berisi data dijadikan 

sebagai header dengan cara klik menu Home → Use First 

Row as Headers. 

5) Tambahkan satu kolom untuk mengidentifikasi pada 

setiap detail apakah Provinsi atau Kab/Kota dengan cara 

klik Add Column → Conditional Column lalu isi variabel 

seperti pada gambar di bawah ini → Ok → Validasi tipe 

data menjadi Text sebagaimana dapat dilihat pada Gambar 

8. 

 

 
Gambar 8. Add Conditional Column Pada Power BI 

 

6) Tambahkan kolom satu lagi yang akan digunakan sebagai 

identitas lokasi untuk membuat visualisasi peta dengan 

cara klik Add Column → Custom Column lalu isi variabel 

seperti pada gambar di bawah ini → klik Ok → Validasi 

tipe data menjadi Text sebagaimana dapat dilihat pada 

Gambar 9. 

 

 
Gambar 9. Add Custom Column pada Power BI 

 

7) Setelah selesai melakukan transformasi, selanjutnya data 

DAU 2018 sudah dapat dimuat dengan cara klik menu 

Home → Close & Apply. 

8) Sebelum melakukan visualisasi pada Data Model, berikan 

gaya koma (style comma) pada kolom Belanja Pegawai, 

Penduduk, Luas Daratan, Luas Lautan, Total Luas 

Wilayah, IKK, IPM, PDRB per kapita, PAD, DBH Pajak, 

DBH SDA dan Alokasi DAU. Selain itu ubah kategori 

data kolom Location dari Text menjadi City. 

 

e.   Analitika Data DAU Menggunakan Visualisasi Pada 

Power BI Desktop 

Selanjutnya, analitika data DAU telah dapat dilakukan 

dengan memvisualisasi menggunakan Power BI Desktop. 

 
(1) Analisis 10 Besar Data DAU dibandingkan dengan Total 

Luas Wilayah. 

Untuk membantu mengekstrak data DAU Formula tahun 

2018 sebanyak 542 kali, maka penulis menggunakan kode 

Python yang tersedia pada Analisis 10 Besar Data DAU 

dibandingkan dengan Total Luas Wilayah. 

 

 
Gambar 10. Pengaturan Field 

 

Hasil visualisasi untuk 10 Besar Data DAU dibandingkan 

dengan Total Luas Wilayah untuk Provinsi dapat dilihat pada 

Gambar 11. 

 

 
Gambar 11. Visualisasi Top 10 DAU Dibandingkan Dengan 

Total Luas Wilayah 

 

Dari visualisasi tersebut dapat diketahui 10 besar DAU 

untuk provinsi dan terdapat penyimpangan pada Provinsi 
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Papua dimana dengan total luas wilayah tertinggi akan tetapi 

alokasi DAU-nya hanya berapa di posisi ke-5. 

 
(2) Analisis Penduduk dibandingkan dengan Total Luas 

Wilayah untuk Kabupaten/Kota.  

Untuk menganalisis Penduduk dibandingkan dengan Total 

Luas Wilayah untuk Kabupaten/Kota, langkahnya pilih 

Visualisasi Scatter Chart → Tarik dan atur field ke Filters dan 

Fields sebagaimana dapat dilihat pada Gambar 12. 

 

Gambar 12. Pengaturan Field 2 

 

Hasil visualisasi untuk Analisis Penduduk dibandingkan 

dengan Total Luas Wilayah untuk Kabupaten/Kota dapat 

dilihat pada Gambar 13. 

 

 
Gambar 13. Hasil Visualisasi Analisis Penduduk 

Dibandingkan Dengan Total Luas Wilayah Untuk 

Kabupaten/Kota 

 

Dari hasil visualisasi, dapat dianalisis terdapat 2 

kabupaten yang menyimpang jauh dari yang lainnya yaitu 

Kab. Bogor (penduduk terbanyak) dan Kab. Merauke (terluas 

wilayah). 

(3) Analisis IKK per Provinsi. 

Untuk menganalisis IKK per Provinsi, langkahnya pilih 

Visualisasi Scatter Chart → Tarik dan atur field ke Filters dan 

Fields sebagaimana dapat dilihat pada Gambar 14. 

 

Gambar 14. Pengaturan Field 3 

Hasil visualisasi untuk IKK per Provinsi dapat dilihat pada 

Gambar 15. 

 

 
Gambar 15. Hasil Visualisasi IKK per Provinsi 

 

Dari hasil visualisasi, dapat Provinsi Papua memiliki IKK 

yang paling tinggi (tidak sejahtera) dan Provinsi Sulawesi 

Tengah memiliki IKK yang paling rendah (sejahtera). 

 
(4) Analisis data DAU dibandingkan dengan Total Luas 

Wilayah menggunakan Peta. 
Untuk menganalisis data DAU dibandingkan dengan Total 

Luas Wilayah menggunakan Peta, langkahnya pilih 

Visualisasi ArcGIS Map sebagaimana dijelaskan pada bagian 

sebelumnya → Drag dan atur field ke Filters dan Fields 

sebagaimana dapat dilihat pada Gambar 16. 
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Gambar 16. Pengaturan Field 4 

Selanjutnya kita buat visualisasi satu lagi sebagai menu 

filter panel yang memuat Jenis Daerah dengan cara klik pada 

area kosong pada canvas → Visualisasi Table → Tarik fields 

Jenis Daerah ke Values sebagaimana dapat dilihat pada 

Gambar 17. 

 

 
Gambar 17. Pengaturan Field 5 

 

Hasil visualisasi untuk Analisis data DAU dibandingkan 

dengan Total Luas Wilayah menggunakan Peta dapat dilihat 

pada Gambar 18. 

 

 
Gambar 18. Hasil Visualisasi Map 

 

Dari hasil visualisasi, dapat dilihat apabila lingkaran 

semakin besar lingkaran, maka mencerminkan Total Luas 

Wilayah yang semakin besar. Sedangkan apabila warna dari 

lingkaran semakin tua, maka Alokasi DAU semakin besar. 

 

 

IV. KESIMPULAN DAN SARAN 

Analitika data merupakan bagian yang tidak terpisahkan 

dari pengelolaan keuangan negara. Penelitian ini berupaya 

untuk menghasilkan suatu artefak aplikasi teknologi informasi 

berupa prosedur penggunaan perangkat Power BI Desktop 

untuk menyajikan analisis data dasar DAU dengan 

pendekatan visualisasi - deskriptif.  Penelitian menyimpulkan 

bahwa implementasi analitika data keuangan negara 

bergantung pada dua hal utama: (1) penyediaan data keuangan 

negara secara bebas di situs web pengelola keuangan negara 

(dalam hal ini data dasar DAU) dengan struktur yang mudah 

diolah kembali memungkinkan para pihak yang 

berkepentingan dengan data tersebut mempunyai kesempatan 

untuk memanfaatkan data sesuai dengan kepentingannya, hal 

ini bahkan bisa jadi dilakukan oleh sesama instansi di bawah 

Kementerian Keuangan karena belum tentu data yang 

diinginkan oleh satu unit dapat diakses dengan mudah oleh 

unit yang lain; (2) analitika data keuangan negara dapat 

dilakukan dengan menggunakan perangkat yang tersedia 

secara bebas (tanpa biaya akuisisi), dalam hal use case ini 

yang digunakan adalah Python dan Power BI Desktop, artinya 

analitika data keuangan negara bisa dilakukan oleh siapa saja 

yang menginginkannya. 

Tulisan berkontribusi kepada praktik analitika keuangan 

negara setidaknya dari dua hal: (1) mengajukan definisi 

operasional analitika data keuangan negara; (2) 

mengembangkan use case dari data yang tersedia secara bebas 

dengan menggunakan perangkat lunak yang juga tersedia 

secara bebas. Penggunaan perangkat berupa Python dan 

Power BI Desktop dalam penelitian ini perlu dilihat sebagai 

pilihan praktis saja. Pilihan atas perangkat yang lain tentu saja 

sangat terbuka, bergantung pada kemampuan dan kebutuhan 

data analyts yang akan menggunakan data keuangan negara.  

Saran penulis adalah pembentukan satu portal data di situs 

web Kementerian Keuangan yang menginformasikan data 

keuangan negara apa yang telah tersedia terkait dengan fungsi 

pengelolaan keuangan negara yang berada di bawah 

kewenangannya. Pada situasi yang paling minimal, portal ini 

dapat berupa hanya direktori data saja sehingga pengguna 

dengan menggunakan berbagai teknik dan perangkat analitika 

data yang dimilikinya ada memanfaatkan data tersebut sesuai 

dengan kepentingannya.  
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